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This manual was written, illustrated and produced by Kanwar Sidhu, Tiho
Lucic, Mike Turner, Mark Evans and John Tonks.

Copyright

Copyright © FARRUKH SYSTEMS LIMITED 2001. This manual and the
software described in it are copyrighted with all rights reserved. Neither
this documentation nor the software may be copied in whole or part without
the prior written consent of the copyright owners, except to make archival
copies of the software for a licensee’s own use.

Trademarks

All products or services mentioned in this manual are identified by the
trademarks or service marks of their respective companies or organisations.

Disclaimer

Even though FARRUKH SYSTEMS LIMITED has tested the software and
reviewed the documentation, the company makes no warranty or
representation, either expressed or implied, with respect to this software and
documentation, its quality, its accuracy, performance, merchantability, or
fitness for a particular purpose. This documentation is subject to change
without notice, and should not be construed as a commitment or representation
by FARRUKH SYSTEMS LIMITED.

Restricted rights

Use, duplication, or disclosure by the Government is subject to restrictions as set
forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and
Computer Software clause in DFAR52.227-2013 or the equivalent clause in FAR
52.227-14, whichever is applicable.

Imposition Publisher™ is a trademark of Farrukh Systems Limited,
Clarendon House, Borehamwood, Hertfordshire WD6 1AG England.
Telephone +44-20-8207-4249, Facsimile +44-20-8207-5992. All rights are
reserved.
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Licence Agreement

THIS IS A LEGAL AGREEMENT BETWEEN YOU, THE USER, AND
FARRUKH SYSTEMS LIMITED.

CAREFULLY READ THE FARRUKH SYSTEMS LIMITED LICENCE
AGREEMENT & DISCLAIMER BEFORE INSTALLING THE SOFTWARE.

BY INSTALLING THE SOFTWARE YOU ARE AGREEING TO BECOME
BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT ACCEPT
THE TERMS OF THIS AGREEMENT YOU MAY RETURN THE UNUSED
SOFTWARE TO YOUR PLACE OF PURCHASE AND YOUR MONEY WILL
BE REFUNDED.

LICENCE
1. You must register with Farrukh Systems Limited in order to identify

yourself as the Licensee. Ownership of the Imposition Publisher Page
Pairer Software Package ("the Software") is NOT transferred to the
Licensee. Farrukh Systems Limited hereby grants the Licensee a non-
exclusive licence to use the server part of the Software on a SINGLE server
computer and the client part on multiple workstations.

2. You may make backup copies of the Software.

3. You may NOT give copies of the Software to another person or transfer the
licence to another person.

4. Farrukh Systems Limited reserve the right to terminate this licence upon
breach.

5. Product specifications and features are subject to change without notice.

6. In no form or fashion can this Software be modified, recompiled, added to
or re-released as a collection, subset or superset of the programs included in
this Software that competes with any edition of Farrukh Systems Limited
products.

7. The Licensee agrees to ensure that anyone employed by or under the
direction and control of the Licensee who comes into contact with the
Software abides by the terms and conditions of this Licence (including,
without limitation, not knowingly permitting anyone to use any portion of
the Software for the purposes of deriving its source code). If the Licensee
becomes aware that the Software is being used in a manner not authorised
by this Agreement the Licensee shall use all reasonable efforts to have
such unauthorised use immediately cease. The Licensee shall notify
Farrukh Systems Limited if the unauthorised use continues for an
unreasonable period after the Licensee becomes aware of it.

8. The licensed Software is protected by copyright and other proprietary
rights of Farrukh Systems Limited. The Licensee may be held directly
responsible by Farrukh Systems Limited for acts done by the Licensee or on
behalf of the Licensee relating to the Software which are not authorised
by this Agreement.

9. Farrukh Systems Limited may at its sole discretion offer the Licensee
updates and upgrades of the Software. Farrukh Systems Limited reserves
the right to require the payment of an additional fee for such updates or
upgrades.

10. The Licensee is solely responsible for the choice of the licensed Software to
achieve the Licensee's desired results.
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INTRODUCTION TO PAGE
PAIRER™

Page Pairer is designed to impose newspaper pages automatically. It is built
around the core Farrukh Systems' Imposition Publisher™ technology. This
has been used for imposing books and magazines since 1990, and is used by over
4,000 customers world-wide.

Page Pairer has all the functionality needed by the largest and smallest
newspapers, yet it is very easy to use. Once the parameters for a newspaper
have been set, Page Pairer automatically pairs the pages as they arrive,
without any user intervention.

Page Pairer uses a client server architecture. The server part runs on UNIX
(Sun, SGI and MacOS X Server) or Windows NT/2000 Server. The control and
monitoring part (client) runs on an Macintosh. This approach gives Page Pairer
the performance of a server application with the ease of use of a Mac. The Mac
client displays the progress of all the pages, so the entire newspaper can be
managed remotely.

Page Pairer accepts as input either PostScript or PDF files; single-page files,
double-page spreads and multiple-page files.

Pages are paired according to a scheme derived from the number of pages in the
publication. Each file has to have a numeric extension indicating its page
number in the publication. Pages can be saved individually (or in double page
spreads) as PostScript or PDF file, from a DTP application. Page Pairer
watches a designated input folder and when the pages for a pair or four-up
have arrived, these files are processed and written to the output folder. The
input files are then moved out of the input folder. This continues until all pairs
or four-ups for the publication have been processed. Once the queue is reset,
Page Pairer will begin waiting for files to process from the next issue of the
publication.

Any pair (or four-up) in a set of files can have a number of duplicates assigned
to one page. This means that a pair (or four-up) can be processed with a number
of different versions of one of the pages. So that if six different copies are sent
of one of the pages and six duplicates have been assigned to that page, then six
different versions of the pair (or four-up) will be created.

The processing of a set of pages that constitute a publication – a newspaper,
magazine or catalogue – is defined as a queue in Page Pairer. A queue consists of
an input directory (inside which three directories get created: ADMIN,
DONE, and ERROR) and an output directory (inside which TMP and
PREVIEW directories get created) for PostScript or PDF files, the number of
pages in the job, the marks required, plus other related set-up information.
Multiple queues can be set-up within Page Pairer, each servicing a different
publication. Pairs or four-ups from different queues will be processed
concurrently although there is an adjustable limit to the number of queues
processing at any one time.

The Page Pairer software consists of two programs, the Client Manager and the
Client program. The client manager program runs on the server, services queues
and processes PostScript files in the background. The client manager writes
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every action related to a queue and any errors to a log file called Queue.log
which is in the ADMIN folder of each queue. The UNIX based version also
writes its own progress information to the terminal from which it was started.

The client program runs on a Macintosh computer. It is used to set-up and
monitor the queues. It does not do any of the processing. The client program can
only be used when the client manager program is running.

The Page Pairer comes with Unlimited or 5 queues licence. Also it allows use
from 5 specific workstations for setting up queues and monitoring queue
progress.
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PAGE PAIRER INSTALLATION

System Requirements of Page Pairer

Server:

Windows NT & Windows 2000:
• Pentium 233 / DEC Alpha XL300 or greater
• 64 MB RAM
• Windows NT Server 4.0 or later
• Sufficient hard disk space for input and output PostScript files

Solaris:
• SunSparc 20
• 64 MB RAM
• Solaris 2.4 or later
• Sufficient hard disk space for input and output PostScript files
• Helios EtherShare or similar

SGI:
• SGI O2 or greater
• 64 MB RAM
• IRIX 6.0 or higher
• Sufficient hard disk space for input and output PostScript files
• Helios EtherShare or similar

MacOS X:
• PowerPC G3 or later
• 64 MB RAM
• MacOS X Server
• Sufficient hard disk space for input and output PostScript files
• Helios EtherShare or similar

Client Workstation

Apple Macintosh:
• System 8.1 or higher
• 48 MB RAM
• 15 MB hard disk space to install
• An Ethernet connection to the Server over a network
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INSTALLING AND RUNNING THE SERVER ON UNIX
Note: In the examples given, any text appearing between angle brackets (< >) denotes text to
be substituted by the user, as it may be site specific.

Installation

The installation CD contains the UNIX software for Page Pairer. The installation .tar file can
be found inside the UNIX folder on the CD. Copy this file to your UNIX server. Then change
directory to /usr/tmp. Then type the following to extract the installation files from the .tar
file.

tar xvf <name-&-path-of-the-.tar-file>

Then to install the software make sure you are in the directory that you extracted the tar files
to. Then become root or superuser by typing :-

s u

< enter password here if any >

Note: If you received a dongle with your copy then you should follow the instructions on the
flyer before running the install script.

Then type :-

./install_ips

The install script will ask you for:

1. An installation path. This is where the server software will be installed, inside a
directory named ipserver.

2. The UNIX directory name and path, which maps onto the shared login Macintosh
network volume. Make sure that the path you enter is correct, as otherwise the server
software will not work.

Once you have answered these two questions the installation will start.

3. Once this is complete you will be asked if you wish to create automatic start-up and
shut down links. If you answer yes, the software will automatically be stopped and
restarted when the machine is brought down and rebooted.

4. Next you will be asked if you received a dongle with your copy:-

If you answer y (for yes) to this question you will be asked if you want to run the dongle
setup program. Again if you answer y (for yes) you will then be asked which serial
port your dongle is attached to (a or b). Then you will be asked to enter your 12-digit
dongle code and release code (you should have received these on a flyer with your
dongle).

If you answer n (for no) to this question the software will print out a reference for your
machine and ask if you have a password for this reference. At this point phone your
supplier with your reference number and they will give you a password and release
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code in return. Then answer y (for yes) to the password prompt and enter your password
including the dashes (-) and release code without dashes.

5. The next step is to setup the printers and volumes to be used with the Clients. If you are
using any combination of EtherShare, PCShare or UShare this can be done
automatically. Just select the appropriate option on the Network Setup menu.

If you are using another networking solution select Other... from the menu option list
and follow the instructions below to setup your printers and volumes.

Setting up Printers

The menu driven script (setup-printers) allows you to manually add or delete names
from the list of printers seen by the clients and to specify a UNIX print command.
When you print from a Client, the server software uses this command to print your
output to a UNIX printer. It does this by adding the printer name and the output file to
the UNIX print command.

For Example: Using Helios EtherShare printer queues, you can follow these steps for
Page Pairer Server to print to these queues.

a. Type the following command to list all EtherShare printer queues :-

<name-&-path-of-your-EtherShare-directory>/lpc
stat

This will list all the EtherShare printer queue names and their associated status.

b. Choose option 1 Add a printer... from the menu. Then type in the EtherShare
printer names pressing RETURN after each. When you have finished press
RETURN to return back to the menu screen.

c. Choose option 4 Configure print command... from the menu. Then enter y and press
RETURN to change the current UNIX printer command. Then enter the following
and press RETURN :-

<name-&-path-of-your-EtherShare-directory>/lpr -P

d. From the menu screen choose option 5 Quit.

Setting up Volumes

The menu driven script (setup-volumes) allows you to manually add or delete volume
entries from the list of volumes seen by the Clients.  Only those volumes that have
been set up this way can be used with the Page Pairer Software.
To add a new volume you should select choice 1. You will be prompted for the UNIX
path and the corresponding Macintosh name.  All names are case sensitive.  Changes
are saved when you select choice 4 Quit.
Note: You will not be able to use the software until at least one volume has been set up.

6. Before finishing you will be prompted to search for Distiller. You should answer y if
you want to preview files and have Acrobat Distiller installed on your UNIX server.
In the ipserver/ip folder the file ippreview.cmd will be created which will contain
path to the Distiller. It is in the form IPPREVTOOL=/usr/bin/distill and if you wish
you can edit it manually (e.g. in case you have multiple installation of the Distiller).
Note: Distiller is not currently available for the Mac OS X Server.
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Your Page Pairer software should now be installed correctly.

Starting the Server

The Server software on UNIX must be running before you can run your Client software.

If the automatic startup option was selected on installation, the Server program will
automatically start when you reboot your machine and will be stopped when your machine is
shutdown.

However, if you wish to start it without rebooting do the following:

1. You must be root or superuser. If you are not, type :-

s u

< enter password here if any >

2. Change directory to the ipserver directory. Type:

cd <my-installation-path>/ipserver

Note: the text <my-installation-path> denotes the first install path you entered when you
ran the installation script.

3. Type :-

./start-ipserver
or

./start-ipserver -DEMO

to start as demo.  If you are starting as demo you will be given a 12-digit demo key.  If you
phone Farrukh Systems with this key, you will be given a release code that will last for a
fixed number of days.  This key is invalidated if the software is shut down, but you can phone
again for another release code. Other than this the demo mode is fully functional.

Note: When starting up a Macintosh client for the first time, you will be prompted to select
the login folder on the server volume. This folder is called iplogin and will have been created
by the server installation script.

Stopping the Server

If you need to shutdown the Page Pairer software without shutting down your machine do the
following:

1. From the same directory and as root or superuser, type :-

./stop-ipserver
or

./stop-ipserver -DEMO

if you are running as demo.
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Miscellaneous

1. If you incorrectly type the UNIX path name for the shared Macintosh login volume in the
installation, you can edit the .ipconfig  file, as root, in the ipserver directory. The format
is as follows :-

APPDIR=<ipserver directory path>

LOGINDIR=<iplogin directory path>

NETDIR=<directory path for the Mac network volume>

2. You can obtain your installation reference number at any time from the ipserver directory
by typing as root or superuser:-

./ipref

3. If you did not enter your password at the end of the installation script, you can do so from
the ipserver directory as root or superuser by typing :-

./ippass enter

  Next, type:-

./ippassrelease

to enter the release code. 

4. If you have a problem entering your dongle code on installation then you can re-enter i t
from the ipserver directory as root or superuser by typing :-

./dngsetup –DNGNUMONLY

5.     You can update your list of volumes and printers after installation from the ipserver
directory, as root or superuser, by typing :-

./config_net



Installation

14

INSTALLING AND RUNNING THE SERVER ON
WINDOWS NT

Installation from CD

1. Insert the installation CD into your computer's CD-ROM drive.

2. Start File Manager or Windows Explorer and view the contents of the CD-ROM Drive. The
folder PagePairer\NT is at the root of the CD. Double click the file setup.exe which will
launch the installation program.

3. Follow the instructions given by the installation program. During the installation you will
be given the opportunity to change the location of the directory that the software is
installed to and the software's Program Manager group.

4. When the installation is complete a new program item (Page Pairer) will appear on the
Start Menu under Programs.

Dongle Driver Installation

Before you can run Page Pairer, the driver for the dongle must be installed on your Windows NT
system. This should happen automatically the first time you try to run the Server program. A
message box should then appear reminding you to restart your machine.

If the driver installation is unsuccessful, you can try a manual installation. Follow the
instructions in the file ReadMe.txt in your Page Pairer Server directory. Then reboot your
machine.

Note: If you try to run Page Pairer Server before installing the dongle driver or before
you have rebooted the machine, Page Pairer Server will not run.

Running Page Pairer for the First Time

When you first run Page Pairer Server, a dialog will appear prompting you to enter your
dongle number and release code, and the path of the shared directory on your Windows NT
machine.

The first time you run Page Pairer Server: -

1. Make sure that the dongle you received with this copy is connected to the parallel port on
the back of your computer.

2. Double click the Page Pairer icon in the Page Pairer program group.

3. In the dialog that appears, enter your 12-digit dongle number and release code in the boxes
provided. (The numbers will be printed on a separate flyer).
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4. In the same dialog, enter the path of your network shared directory in the box provided.

E.g. The shared directory to enter would be D:\ if all of the D: drive files and directories
could be seen from the network volume on your Client machines.

5. Click OK. The Page Pairer main window and splash screen should appear.

Next time you double click the Page Pairer icon the software will start up
straight away with the Page Pairer main window and splash screen.

Note: If you type the network shared directory path incorrectly, the Server software will
start up, but the clients will be unable to login. If this happens choose Reset Installation from
the Edit menu.  The next time you start the server program the installation dialog will
appear. Then you will be able to enter the correct shared volume path.
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INSTALLING AND RUNNING CLIENTS

1. Before installing and running Page Pairer Clients, make sure the Server part is already
installed and running.

2. Make sure you are able to see the server on your desktop. If not make sure the Network
control panel is switched to Ethernet and that the Chooser is switched to AppleShare.
You should then be able to see your server and be able to mount its volumes on to your
desktop.

3. Install Page Pairer on your Macintosh.

4. Run Page Pairer.

5. You will be prompted to personalise your copy. Enter your name and company. You do not
have to enter a Dongle Number and Release Code for the Client software.

6. Click on OK to bring up the Client Server Setup dialog:
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7. Click the Install Server button. You are then prompted to login to a Server:

8. Click on the Select Login Folder button. Navigate to the network shared volume and select
the iplogin folder (this folder is created by the Server on its first run):

9. Enter a login name (up to 8 characters). Then click Login.
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10. The Client Server Setup dialog allows you to simultaneously log onto multiple Servers, i f
required.  Click Done to complete the login procedure.

Now you are logged in, you are ready to go.

Note: The next time you run Page Pairer, logging in to the server will be automatic.

If there are any problems installing or logging onto the
Server

If the Server is unable to log you in, then check the following:

• Try repeating steps 5-10.
• The Server part is actually running
• The Server's volume is mounted on your desktop and so is visible to Page Pairer
• The correct login folder has been selected
• A correct login name has been supplied. If the name is already in use you will need to

enter another name and try again.
• If the number of users logged in to the server has reached the limit allowed by your

user licence, then you will not be allowed to login. You will need to uninstall one of the
other users  (See below for how to do this).

If nothing seems to work then contact your supplier or Farrukh Systems directly. (See the
ReadMe file for how to get Technical Support).
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REFERENCE GUIDE

About the Reference

This chapter contains descriptions of all the functions of the software. It is
most useful as a reference. The material in this chapter is organised into the
following sections:

File Naming

Page Pairer uses a special naming convention for input and output files.

Queue List

Maintains an overview of all the queues. This is the main entry point for queue
management.

Queue Progress Window

Monitors the progress of an individual queue.

Queue Setup

Creating, editing and viewing queues.

Pair Options

Options for individual pairs or four-ups, including duplicate pages.

Queue Trims

Imposition values such as trims and creep.

Printing

Custom job settings for printing.

Device Setup & Alignment

Setting up printer devices and aligning output. Rotation of pairs / four-ups is
done here.

Print Marks

Selecting print marks such as crop marks and user labels.

Preferences

Setting up some general preferences for Page Pairer.

Uninstalling Users

Describes how to uninstall users from the Client or Server

Setting up Different Security Levels

Describes how to set up different access levels
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PPCONFIG File
Short explanation of all parameters in the server configuration file
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FILE NAMING

Input File Name Format

Unless the AutoDetect driver has been selected, input files for a particular
queue must all be of the same PostScript type (i.e. from the same DTP
application) and be of the same PostScript type as that chosen for the queue.
Also all files should be created using the same version of DTP application and
printer driver.

It is recommended that you save your input PostScript files with crop or
registration marks. If you are saving a double page spread from an application
such as QuarkXPress make sure that you check the “spreads” option in the
print dialog when you save the file to disk as PostScript.

The files that you input to Page Pairer must follow the following naming
convention. A file name consists of a base name and a file extension separated
with a dot/period.  Files can have any valid base name, but must end (or begin
– see PAGENUM_FIRST flag in PPCONFIG file) with a specific dot-number
extension.

Single page files dot-number extension .16

Double page spreads dot-number-d extension .16d or .16D

Printers pairs dot-number-p extension .02p or .02P

Multiple page files dot-number-dash-number extension .2-6

The part of the file name before the extension can be different for each file sent
to the queue. Some examples of valid input file names are given below: -

Single Page Files

coverpage.1

Double Page Spreads

centerpages.16d

Or,

centerpages.16D

A double page spread input file would be considered as one whole pair. For
example, to pair a 32 page job if pages 16 and 17 constitute a double page
spread, then there only needs to be one input file for this pair (e.g.
centerspread.16D) No other files are required for the pair.
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Printer Pairs

If a file name has the suffix 'p' or ‘P’ the two pages in the file will be treated
as printer pairs. For example, in a 16-page queue file 'spread.2p' would contain
pages 2 and 15.

Multiple Page Files

Input files can contain several pages. The extension specifies first and last
page in the file. For example, a five page file (pages 2 through 6) would have
to be named like this:

filename.2-6

Duplicates

If you have assigned duplicates to a pair (or four-up) then you have to send a l l
versions of the duplicate page plus a single copy of each of the other pages in
the pair (or four-up). The different versions of the duplicate page should have
a different base name (the first part of the name excluding the extension). As
the duplicate base name is used in the output file name. The different base
names will then allow you to recognise which duplicate copy of an output f i le
is which. For example a pair containing pages 3 and 14 with 4 duplicates
assigned to page 3, the set of input files could be: -

picnorth.3
picsouth.3
piceast.3
picwest.3
textonly.14

In the above example the first duplicate page 3 seen will be processed with
page 14. Then that copy of page 3 will be moved to Done folder. The next
available copy of page 3 will be looked for and again processed with page 14
when found. This continues until the number of duplicates assigned to page 3
have been found and processed. The last page 3 and page 14 are then moved to
Done folder.

For a pair with duplicates assigned to a page, if you send a double page spread
input file, the file will count as one duplicate page and the other page in the
pair and will be moved to Done folder after processing. The same applies for
adjacent left and right pages in a four-up.

Points to remember

The naming convention described in this section must be followed correctly for
your jobs to work. If you send any extra input files, these will be ignored until
the queue's current publication has been processed.

If you send two input files for the same page, without having defined
duplicates, Page Pairer will pair the first file that it finds when it scans the
input folder.

For a pair containing a page with duplicates assigned, if single page files are
sent for the first duplicate version, followed by a double page spread for the
second duplicate, some files may be left over in the input directory after a l l
versions of the pair have been completed correctly.
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Output File Name Format

Output files are named according to the following convention. All output f i le
names begin with a job number indicating how many times the queue has been
reset. If no duplicates are present in a pair (or four-up) then the output name
will consist of the job number and then the base file name of the first page in
the pair (or four-up) followed by the page numbers of all the pages separated
by dots. E.g.

J1_coverpage.32.1

Or,

J1_coverpage.1.32.16.17.

If duplicates have been assigned to a pair (or four-up) then the base file name
of the current duplicate page will be used in the output name and an indication
of duplicate and page number appended to the end of the name. E.g.

J1_eastadvert.2.31.dup1pg2

Or,

J1_westadvert.31.2.18.15.dup1pg15.

Note: Page Pairer outputs PostScript files.
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QUEUE LIST

This dialog (opens up automatically on the start-up, or, if closed, can be
invoked from the File menu) displays information about all existing queues.

Buttons

New…

Displays the Queue Setup dialog so that a new queue can be created.

View.. . /Edit . . .

Displays the Queue Setup dialog that displays the information used to set up
the queue. If the queue has been suspended then these settings can be edited.
The queue can then be released for the new settings to take effect. If a queue is
not in a suspended state then the information displayed is read only.

Delete

Deletes a queue from the queue manager. Input and output directories will be
left untouched.

Reset

Resets all pair and duplicate processing information for the queue back to
those set before the first pair in the job was processed.

Suspend/Resume

Suspends any further processing of files by a queue. Any pair currently
processing (the queue will be marked as "ACTIVE") will be reset when you
suspend. Resume will return a suspended queue back to it� normal state.

Progress…

Displays the Queue Progress dialog showing any pair (or four-up) currently
being processed, pages remaining to be processed, pages processed, duplicate
pages processed, and any pages for which an error occurred while processing.
See the section Progress.
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Labels

Name

This field displays the queue name that was assigned in the Queue Setup
dialog.

Type

This field displays the type of processing that the queue will handle e.g.
Pairs or 4-up.

Status

This field displays the current status of the queue. The possible state values
are:

Ready

The queue is waiting for files to process.

Active

The queue is processing.

Done

Processing has completed.

Suspended

The queue has been suspended.

Error

An error has occurred in the queue.

Pages

This is the number of pages for the paper or publication job that was assigned
in the Queue Setup dialog.

Processed

This indicates number of blocks (2-up or 4-up) processed.
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QUEUE PROGRESS

The Queue Progress dialog (can be invoked from either File Menu or Queue List
dialog) shows progress information on any pair (or four-up) currently being
processed, pages remaining to be processed, pages processed, duplicate pages
processed, and any pages for which an error occurred while processing.

Page Status

The current status of any page is indicated by the colour of its icon in the Queue
Progress dialog.

Light Grey Waiting The page has yet to arrive in the input folder.

Dark Grey Arrived The page has arrived in the input folder.

Green Processing The page is currently being processed.

Blue Processed The page has been processed.

Red Error An error occurred during the processing of the page.

Note: The currently selected block/page will have a dark border.
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Command Buttons

Reset Page

Resets the currently selected pair, and the other pages in the block are brought
back into the Input folder.

Reset Pair

Resets the currently selected pair(s). If the pair to be reset is currently
processing then the processing will be terminated.

Hold

Holds currently selected pair(s). If a pair is held it will not be processed until
it is released.

Release

Releases currently selected pair(s).

Hold All

Holds all pairs.

Release All

Releases all pairs.

Preview

Opens an associated Pdf file in Acrobat Reader / Exchange. This button is only
enabled if the currently selected pair has been processed (and Create Preview
Files in Queue Setup has been checked on).

Pop-up Menus

Q u e u e

Lists all installed queues. The currently selected queue is displayed in the
Progress Dialog.

Print Job

Lists all defined Print Job sets. Individual pairs can be assigned different Print
Jobs with this pop-up (the eight letters at the bottom of each block denote
short name of the associated Print Job). If a pair has already been processed
and the Print Job is changed, the pair gets reset and processed again with the
new settings.

Note:  Multiple block selection is possible. Reset Pair, Hold and Release buttons as
well as Print Job pop-up dialog act on all selected blocks.

Information at the bottom of the Progress dialog

No of Blocks:

Indicates the total number of Pairs or 4-Ups.
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Page No:

Displays the number of the currently selected page.

File Name:

Displays the file name of the selected page.
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QUEUE SETUP

This dialog (invoked from Queue List dialog by clicking on New or Edit
buttons) is used to set-up the input and output queues. It is from here that the
page-pairing process controls and preferences can be set.

Queue Setup

Queue Name

Type a name to identify the queue and its associated settings. After this dialog
is confirmed the Queue Name will appear in the Queue List dialog.

Queue Type

Select either 2-up or 4-up.

No of Pages

Specify the number of pages in the complete publication.

Odd Pair (2UP)

When the number of pages for a 2-up queue is not divisible by four, then an Odd
Pair of pages must be specified in this edit field. The pair of pages should be
entered comma separated with the smaller page number first.
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Webs (4UP)

Similar to Odd Pair, but this applies only to 4-up jobs. One or two half-webs
can be specified. The pair of webs should be entered comma separated. Also
the webs can be either Top (default), Bottom, Left or Right. If Insert box is
checked on then pages on webs are in consecutive order.  

Sections

This allows the publication to be split into a number of sections. For example,
‘16,16,32’, would be entered to create 3 sections of sizes 16, 16 and 32 for a 64-
page publication. Note that spaces are not allowed and the section sizes must
be comma separated.

Queue Folders

Input Folder

Specifies the input directory, where input files are placed before processing.
Note that the folder to be selected must already exist and be visible to the
server.

Output Folder

Specifies the output directory where the output files are placed after
processing. Note that the folder must already exist and be visible to the
server.

Queue Printing

Print output files

Sends the output files to a designated printer on the server, as well as being
saved in the output folder.

Create Preview Files

Allows the output files to be previewed before being sent to a designated
printer. This option requires Acrobat Distiller installed on the server and
Acrobat Reader on the client.

Use Job Folders
Organises the output files in different folders inside the Output folder. Each
different print job setting has its own folder. The Job Folder name is the same
as the short name of the associated print job setting.

Default Job Set

The selected Print Job set is set as the default for all print blocks. A different
Print Job for individual blocks can be selected in the Progress Dialog.

Default Page Setup...

The Default Page Setup dialog can be used to change the page size and
margins. These settings are used when Page Pairer cannot detect the actual
page size from the input file. For example, if there are no recognisable crop
marks, then the page size, positioning and margin settings in this dialog are
used.
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Units

Use this popup to change the units for this dialog.

Page Size

S i z e
This popup displays the document page size. It is this size that Page Pairer
will use as the trim page size for printing impositions.

Note: Do not adjust this if the PostScript file was created with crop
marks.

Custom can be used for any non-standard page sizes. If the file was created
with crop marks, Page Pairer can establish the Page Size and margins to the
accuracy of the crop marks. Files created without crop marks might require the
Page Size to be entered manually.

Width
The width of the document page. For custom page sizes, you will need to enter
the page width here. For non-custom page sizes the width is automatically
entered.

Height
The height of the document page. For custom page sizes you will need to enter
the page height here. For non-custom page sizes the height is automatically
entered.

Orientation
Use this button to set the orientation of the pages. Page Pairer can usually
establish the orientation from the file itself.

Margins

This option is used to adjust the position of the page contents within the page
area. This may be necessary if the original file did not have crop marks. The
adjustment can be different for odd and even pages.

Posi t ion
Use this popup to change the position of the page

First Page
Select whether the first page in the block is an Odd page or Even page.
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Odd Page
Enter the horizontal offset that should be applied to all odd pages in the
block.

Even Page
Enter the horizontal offset that should be applied to all even pages in the
block.

Bottom
Enter the vertical offset that should be applied to all pages (odd and even).

Pair Options...

Displays the Pair Options dialog, which allows the setting of custom options
for individual pairs, such as duplicate pages and custom labels.

Trims...

 Displays the Queue Trims dialog that allows the setting of trims and creep for
the output.

Preferences...

Displays the Preferences dialog which allows the setting of the default
PostScript type.

Print Job Setup...

 Displays the Job Setup dialog which also gives access to the Device Setup and
Print Marks dialogs for setting of the output device size and alignment,
defining Print Marks and User Labels.
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PAIR OPTIONS

This dialog allows single pages to be duplicated and processed (paired or four-
up) with different page files. Here a list of page files to duplicate can be built.
Also a custom label can be defined for each block.

Custom Label

Defines a special label that is associated only with the corresponding pair.
The label is updated when the Apply (cmd L) button is pressed.

Duplicates

Page

Specifies the page number on which duplicates are to be applied.

E.g. where the page numbers denote publication page numbers, the front page
files:

FrontEng.1, FrontSco.1, FrontWal.1,

could be paired up with the single back page file:

BackUK.48

This will produce 3 paired output files all containing BackUK.48 but only
containing one from each of the above front page files.

Copies

Specifies the number of versions that Page Pairer expects to process (paired or
four-up) with its corresponding process page or pages. For example, specifying
2 copies would result in 3 processed pairs. The number of copies is updated
when the Apply (cmd D) button is pressed.
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QUEUE TRIMS

This dialog allows the trims to be set for a processed pair or four-up.

Creep

Specifies a creep value. Creep is used to adjust the vertical trim to allow for
the reduction in gutter margin caused by the folding of a sheet.

Bottle

Allows the rotation of each page to be adjusted to compensate for any rotation
caused by folding

Edge Trims

Sets the trim values around the paired output.

Horizontal & Vertical Trims

These edit fields are used to set trims between the output pages. Note tha t
only vertical trim is applicable for a 2-up queue.
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PRINTING

This section is about setting up custom job settings for printing. The Job Setup
dialog gives access to the Device Setup and Print Marks dialogs and allows a l l
the printing attributes to be saved as a Job Set

Job Sets

The Job Setup dialog allows the selection of pre-defined job sets. A job set is a
combination of a Device Setup and a Print Mark Set combined with the
additional options that can be specified within this dialog.

Printer

This popup is used to select the output device to be used for printing on the
server. The selection reflects any output devices that have been defined on the
server.

Device

This popup is used to select the Device Setup to be used by this Job Set

Mark Set

This popup is used to select the Print Marks Set to be used by this Job Set

Print Options

Scale to Fit

Selecting this check box causes the output to be scaled down to the size of the
chosen output device if it would not fit otherwise.
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Horizontal Scaling

If Scale to Fit is not selected then this edit box allows horizontal scaling of the
output. 100% is the default and indicates no scaling.

Vertical Scaling

If Scale to Fit is not selected then this edit box allows vertical scaling of the
output. 100% is the default and indicates no scaling.

Mirror

Selecting this check box causes the output to be mirrored. Mirroring takes place
about the vertical axis.

Negative

Selecting this check box causes the output to be printed negative.

Mirror Yellow Plate

Selecting this check box causes the yellow plate to be printed as a mirrored
image.

Reverse User Label

This option allows the user label to be reversed compared to the rest of the
output.

Save  
Save the current settings to the currently selected job set.

Save As

Save the current settings to a new job set.

Delete

Delete the currently selected job set.
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DEVICE SETUP AND ALIGNMENT

This section is about setting up printer devices for trouble free printing. The
default settings should work fine once you have specified the dimensions of
your output sheet. There is support within Page Pairer for aligning the output
onto the sheet or plate exactly as required.

This section is divided into the following parts:

• Creating, Saving and Deleting Print Devices

• The Device Setup Dialog

• The Alignment Dialog

• Printing to Imagesetters

Creating, Saving and Deleting Print Devices

A print device file contains information about your output device settings and
job alignment. Print devices can be created for any output devices and for any
jobs requiring specific alignment or orientation settings.

Page Pairer displays previously saved devices in a popup menu in the Job
Setup dialog. The device settings can easily be changed in the Device Setup
dialog. To create a new print device, click Save As… and enter a new name. You
can have any number of devices according to your needs.

Creating and Saving Print Devices

1. Click Device Setup... in the Job Setup dialog.

2. Enter the desired values for the new device.

3. Click Save As... to save these values to create a new print device:
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4. Type in the new name and click Save:

The new device will now appear in the Device popup as the current device:

Deleting Print Devices

1. Select Device Setup... from the File menu.

2. Select the device to delete using the Device popup.

3. Click Delete.

4. Confirm deletion of the device by clicking on Yes.

Note: If there is only one device present it cannot be deleted.

Note

As print devices are files in the “IP Devices” folder it is also possible to copy
and delete them using the Finder.
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The Device Setup Dialog

Selecting Device Setup... in the File menu displays the Device Setup &
Alignment dialog:

Device

This popup allows you to select the Printer Device that you wish to edit or
print to.

Units

This popup allows you to select which units to display, for example inches or
millimetres, for the device dimensions and offsets.

Paper

This popup allows you to select the device dimensions.
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Media Width

This is the printable width of the media (film, plate or paper), which may
not be the same as the physical width.

 (See Printing to Imagesetters for details on setting up continuous devices).

Media Height/Max. Depth

Media Height

This is the printable height of the media. This is available unless the Device
is set to Continuous.

Max. Depth

For Continuous devices this value will be used as the maximum depth. If a
block or flat exceeds this depth Page Pairer will tile the output. If the value is
set to zero, then whole blocks are printed in one go.

Printer Offsets

When printing in duplex mode on a laser printer or proofer, frequently, the
pages print slightly off in alignment, front and back. The printer’s image area
can be moved using these offsets. The offsets are measured from the bottom left
corner.

For example, if printing an A5 booklet on an A4 or US Letter size printer, you
can use these offsets to ensure that the pages print centrally. This means tha t
the pages line up exactly on the front and back when printing in duplex mode.

Left Offset

This will move the image area right on the paper by the specified distance. To
move it left a negative value must be specified.

Bottom Offset

This will move the image area up by the specified distance. To move it down,
enter a negative value. Not applicable to continuous devices.
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Block Spacing

The space to be left between blocks, when it is possible to place multiple blocks
on an output sheet.

For example, if it is possible to fit several blocks onto one sheet enough space
needs to be left between the blocks so that the print marks do not overlap. This
does not apply to Page Pairer as only one block is printed at a time.

Strip Printing

Continuous Device only. If this is on, then Page Pairer will minimise the
memory usage on the output device by outputting each block as a number of
strips of pages.

(See Printing to Imagesetters for details on setting up continuous devices).

Save (cmd S)

Save the current settings to the currently selected print device.

Save As

Save the current settings to a new device.

Delete (cmd D)

Delete the currently selected print device.

The Alignment Dialog

The lower half of the Device Setup & Alignment dialog allows you to specify
exactly how the output should be positioned on the device area.

Format

The format is fixed to Odd and Even Blocks for Page Pairer.

It is possible to specify alignment and orientation values for all the odd
numbered blocks different from the even numbered blocks.
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Offsets and orientation settings apply to the blocks indicated in the title of
the Offsets box. The diagram above shows settings for the even numbered
blocks. To specify settings for odd numbered blocks, click on the image of block
1. The Offsets box title will change to Offsets: Odd Blocks.

Punch Holes

Choices for the position of punch holes:

For example, if you select punch holes on the left the preview on the right
hand side changes to show the punch holes.

Alignment Offsets To

Precise control is available by specifying offsets from the edge of your device’s
imaging area to either the edge of finished page or to outside edge of the
block.

This is represented in the display by the thick red line.

Start of Page

Any offsets are measured from the device edge to the edge of the pages in the
block.

Start of Trims

Any offsets are measured from the device edge to the outside edge of the crop
marks.

Alignment Offsets

The settings in the Offsets box control the orientation and position of the block.

Any changes made apply only to the currently selected block.
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Orientation (cmd , cmd )

The orientation in 180° intervals of the block:

Please note that for Page Pairer, only the options 0° or 180° are valid.

Important: If you require the output a specific way around, for example for
Direct to Plate work or for a Punch system, then you should set the
orientation manually.

cmd  orientates the block/tile piece to 0°.

cmd orientates the block/tile piece to 180°.

The orientation of a block or individual tile piece can also be changed, in 180°
increments, by clicking on the block or tile piece in the Alignment Display.

Horizontal

Sets the horizontal alignment for the block. You can set an edge, Left or Right,
or Centred from which to align to and measure offsets from:

Offsets greater than zero will shift the block to the right and offsets less than
zero will shift it to the left.

Vertical

Sets the vertical alignment for the block. You can set an edge, Centred, Top or
Bottom to align to and to measure offsets from.

Offsets greater than zero will shift the block or tile piece upwards and offsets
less than zero will shift it downwards.

Note: This is not available if using a continuous device.

Reset Block

Will reset the orientation and alignment options for the block to default
values.

Reset All Blocks

Will reset the orientation and alignment options for all the blocks to the
default values.
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The Alignment Display

The display below is a representation of the output device and the blocks.

• The device is the background (blue) frame and the block or tile pieces are
clearly labelled.

• The device and the block or tile pieces are NOT drawn to scale.

• The alignment offsets are drawn to scale relative to the device size.

• The Device Leading Edge arrows (pink) indicate the direction of
movement of film through the device and hence which edge of the block
will appear first from the machine.

• The thick red line indicates where the offsets are measured to from the
edge of the device.

• The orientation of the block can be changed in 180° intervals by clicking on
the block itself.

• To switch between different tile pieces just click on the relevant one. The
first click will switch to that tile piece and subsequent clicks will change
the orientation as described above.

• The device size is displayed along the top of the display frame.
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Printing to Imagesetters

Continuous Output Devices

A “Continuous” output device is any roll-fed device that allows different
sheet depths. Page Pairer will automatically calculate the depth needed for
that job and sets up the imagesetter accordingly. In this mode whole blocks, or
tiled sections, will be printed in one go.

There is a Max. Depth value which, if not set to zero, will be used as the
maximum depth of a continuous device. If a block or flat exceeds this depth
then Page Pairer will tile the output. If this is zero, whole blocks are printed
in one go.

To maintain compatibility with older limited memory roll-fed imagesetters,
there is a Strip Printing option. When this is checked, Page Pairer outputs
every row of pages individually, to minimise memory usage.

The Strip Printing option should only be used when the imagesetter is a
continuous roll-fed device and you have been experiencing out of memory errors.
All modern devices should have enough memory to cope without resorting to
Strip Printing.

Important Points to Remember

1. When printing to a continuous device, the width should be set to the
imaging width, which is not necessarily the width of the material.

For example, an imagesetter running 12" (304.8 mm) material, the image
width is typically 303 or 304.8 mm. A rangecheck error from your RIP is an
indication that the value for Media Width is set too large in the Device
Setup dialog.
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PRINT MARKS

You can specify your own particular set of default print marks. The print mark
settings are saved permanently so they may be re-used the next time the
program is used. This section is divided into the following parts:

• The Print Marks Dialog

• Standard Print Marks

• Print Mark Options

• User Label Dialog

• Custom Print Marks

The Print Marks Dialog

The Print Marks dialog is reached either by Selecting Print Marks... in the
Edit menu or from the Queue Setup dialog.

This dialog is used to specify which print marks to use. The list of checkboxes
shows the standard print marks and any custom print marks you may have
created.

Simply check the relevant boxes on and see the marks described appear on the
display.

• The first seven checkboxes, along with the popups, are Standard print
marks. These are permanently installed and cannot be edited, just
switched on and off.

• All other checkboxes are Custom print marks. Page Pairer creates a list of
all the custom marks found and adds them to the list of checkboxes, after
the standard marks.



Reference

47

Save Set (cmd S)

Save the current print mark settings.

Save Set As

Save the current settings to a differently named print mark set.

Delete

Delete the currently selected print mark set.

Labels... (cmd L)

This button will allow you to create a user label or slug. See the User Label
Dialog below.

Custom Marks... (cmd M)

This button allows you to create, edit, copy and delete custom print marks.

See Creating and Editing Custom Print Marks and The Custom Marks Dialog
below.

Mark Options... (cmd O)

This button allows you to adjust offsets for standard print marks and set the
crop mark lengths for the current mark set.

See Standard Print Mark Options below.

Done

Exits the Print Marks dialog. You will be prompted to save the current print
mark set if it has been changed.

Standard Print Marks

Crop Marks

These are marks that appear around the edge of the block indicating the edges
of the individual pages.

Centre Guides

These are marks that appear around the edge of the block marking the centre
line between rows and between columns of pages.

Centre Crosses

These are crosses that mark the centre of a group of four pages.

Page Outline

Pages will print with a dotted outline. These can be used in place of Crop
Marks.



Reference

48

Collating Marks

Page Pairer automatically calculates the position and height of the marks
and can handle multiple collating marks in one block. Page Pairer will start
with the first collating mark starting at the top and will work down. If the
first block required is not the first block in the imposition, you can adjust the
position of the first collating mark by setting Signature Start At to something
other than A.

For example, if the first block were the third block in the imposition, you
would set Signature Start At to C.

Signature Marks

This is used to specify:

a ) a label to be printed on each block indicating the block letter and whether
it is an outer or an inner block.

b) a letter to be printed at the foot of the first page of each section indicating
which section it is.

Signature Start At

This is used to specify, within the imposition, the location of the first block
being imposed. If it were the fourth block being imposed first, this field would
be set to D. Changing this field affects both the Collating Marks and the
Signature Marks.

User Label/Slug

This allows the user to specify whether to print a user label or not. See the
User Label Dialog below on how to create and position labels.

Registration

Select the positions you require from the following:

Colour Bar

This is Page Pairer’s standard colour bar. It will print along the length or
width of each block and will colour-separate if necessary. It can print up to 6
colours in one strip, so that for more than 6 colours extra strips will be printed
alongside the first one. Select the position you require from the following:
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CPC 4 Mark

These are Heidelberg CPC 4 Marks and are included with our software as part
of the standard package. Select the positions you require from the following:

Grip Mark

This is used to specify where, if at all, the side guide mark should appear.
Select the position you require from the following:

Custom Print Marks

Page Pairer adds any custom print marks found to the list of checkboxes in the
Print Marks dialog. Custom Print Marks can be checked on or off as needed in
the Print Marks dialog. When switched on, the custom marks will appear in
the right hand display, roughly to scale, in the correct position and size
relative to the page.

Disabled Custom Marks

If an EPS file associated with a custom mark cannot be located, then the mark
name appears in red.

To enable it, either:

•  Click on the check box to search for the EPS file.

•  Double-click on the custom mark to search for the EPS file and edit the
custom mark.

See Creating and Editing Custom Print Marks and The Custom Marks Dialog
below.

Preview EPS

If this is checked, then a preview image of each custom mark will be
displayed (if available).

If this is not checked, then any custom marks will be displayed using a general
EPS icon. This can be useful if custom marks based on large complex EPS files
take a long time to display.
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The User Label Dialog

Click User Labels... in the Print Mark dialog. The Label and Slug Options
dialog appears:

This dialog allows you to create a label that will print with each block.

Font

This specifies the font and size that the label text is printed in. There is a
choice of three fonts:

Position

This specifies where on the block the label prints. The following choices are
available:

Section Spine is the gutter between the first and last pages of each section i.e.
the spine.

Note: If the User Label/Slug check box is switched on then the user
label/slug will be displayed at the position that was selected here.
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Units

The offsets can be measured in various units via the Units popup next to the
offsets.

Offsets From

This specifies whether to measure the offsets from the edge of the page or from
the edge of the trim area.

Offsets In From Corner, Offsets Away From Edge

These offsets can be used to position the user label anywhere on the block. The
offsets are measured from the selected position above.

Label Icons

Imposition Name (cmd I)

This will place a marker in the label that will be replaced by the imposition
name when printing.

Date & Time (cmd D)

This will place a marker in the label that will be replaced by the date and
time of the job when printing.

Block # (cmd B)

This will place a marker in the label that will be replaced by the block
number of the current block being printed.

Plate Colour (cmd P)

This will place a marker in the label that will be replaced by the plate colour
of the current block being printed.

Signature(s) # (cmd S)

This will place a marker in the label that will be replaced by the signature
letter or number of the current block being printed.

Document Job Title (cmd J)

This will place a marker in the label that will be replaced by the Job Title
from the current PostScript file being printed.

NB This feature is not applicable to all types of PostScript files.

<filename>

This has to be typed manually. It will place the output filename in the user
label.
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When you have finished setting up your User Label, click on OK to return to
the Print Marks dialog.

Standard Print Mark Options

Click Mark Options... in the Print Mark dialog. The Standard Mark Offsets
dialog appears:

Units

The units in which to display the offsets.

Offsets from

This specifies whether to measure the offsets from the edge of the page or from
the edge of the trim area.

Crop Mark Length

Crop mark length is equal to the value specified in the Crop Mark Length box.
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Registration, CPC 4 and Grip Mark Offsets

These offsets are the values used to position the above marks from their
positions selected in the Print Marks dialog.

Colour Bar Offset

This offset is the distance to the start of the colour bar from the edge selected
in the Print Marks dialog.

Custom Print Marks

This section explains how to set up custom marks. Custom marks are special
print marks based on EPS files.

Creating and Saving Custom Print Marks

1. Select Marks Setup... from the Edit menu.

2. Select Custom Marks... from the Print Marks dialog.

This brings up the Custom Marks List dialog where it shows the list of
available custom marks.

3. Select New... from the Custom Marks List dialog.

Figure 0-15 Custom Marks List

This brings up the Custom Mark Options dialog where you can set up the new
custom mark.
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Once in the Custom Mark Options dialog, you must:

4. Type a name for the custom mark in the Name field.

5. Click on Select EPS... to choose the EPS mark using the standard file
selection dialog.

6. Select at least one Position to print the custom mark.

7. Enter any other options you may want. Other options available are:

• The orientation (0°, 90°, 180°, 270°).

•  Which blocks to print the custom mark on.

• The hot spot: a point on the EPS that lines up with the selected
position.

• The mark scaling (between 1% & 1000%).

• Offsets relative to the chosen position(s).
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8. Click Save to save the custom mark with the given name.

Note: Until an EPS file and at least one position have been selected the mark
cannot be saved.

Once saved the new custom mark will appear in the Custom Marks List dialog:
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It will also appear in the Print Marks dialog as a check box in the list:

To use this custom mark simply check it on. It will then appear in the display
at the position(s) selected:

Editing Custom Print Marks

To edit a custom print mark:

1. In the Custom Marks List dialog click Edit... to edit the currently selected
custom mark. Or double-click the custom mark. Alternatively, in the Print
Marks dialog, double-click the custom mark name or click the small
Information button in the list of print marks.

The Custom Mark Options dialog appears:
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2. Make the changes required in the Custom Marks dialog.

3. Save the custom mark.

Copying Custom Print Marks

1. Select Marks Setup... from the Edit menu.

2. Click Custom Marks... in the Print Marks dialog.

3. Select Copy... to copy the currently selected custom mark in the list.

Deleting Custom Print Marks

1. Select Marks Setup... from the Edit menu.

2. Click Custom Marks... from the Print Marks dialog.
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3. Click Delete... to delete the currently selected custom mark in the list.

4. Confirm delete by clicking Yes.

Note: as the custom marks are stored as files inside the Marks folder it is
also possible to copy and delete custom marks using the Finder.

The Custom Marks List Dialog

This dialog shows all the custom marks in the Marks folder and allows you to
create, edit, copy and delete custom marks.

New... (cmd N )

Click New... to create a new custom mark.

Edit... (cmd E )

Click Edit... to edit the currently selected custom mark.

Copy (cmd C)

Click Copy... to copy the currently selected custom mark.
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Delete (cmd D )

Click Delete... to delete the currently selected custom mark. You will be asked
to confirm this as a precaution.

The Custom Mark Options Dialog

This dialog allows you to set up the new custom marks and edit existing custom
marks.

The square EPS preview diagram is used to display all EPS files whatever
orientation is selected.

The long thin EPS preview diagram is useful for displaying colour bars. The
orientation selection has no effect on this preview. If you create your own EPS
files, we recommend creating horizontal rather than vertical colour bars for
best use of this display.

Name

This is the name of the custom mark. It is up to you to choose a name for the
custom mark.

File

This is the name of the EPS file to be associated with the mark. This can
reside anywhere on any volume. Once an EPS file has been selected, the name
and size in K (kilobytes) are displayed here.

Note: If this is empty, i.e. no EPS file has been selected, then the custom
mark cannot be saved.

Size

Once an EPS file has been selected, the dimensions of the EPS file are
displayed here in the chosen units.
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Units

The units in which to display the custom mark offsets and the dimensions of
the EPS file.

Select EPS (cmd S )

Allows you to select an EPS file for the custom mark and/or change the EPS
file for an existing custom mark.

Note: Until an EPS file has been selected the custom mark cannot be saved.

Preview EPS

Switches EPS previewing on or off. If the EPS preview takes too long to
display, then switch previewing off.

Positions

There are nine possible positions for each custom mark. They are all marked by
checkboxes:

 Check on the positions at which the custom mark should print.

Note: Until at least one position has been selected the custom mark cannot be
saved.

Offsets From

Allows you to decide whether the offsets should start from the edge of the
page or the edge of the trim area.

Offsets

These are the horizontal (X) and vertical (Y) offsets that can be used to
position the EPS mark anywhere on the block. The offsets are measured from
the selected position(s) above.

Scale

This allows scaling up or down of the EPS mark. Choose values between 1%
and 1000%. If the EPS mark is re-scaled the preview displays will reflect
this.
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Orientate

This allows the EPS mark to be rotated to the correct orientation. Choose
between 0°, 90°, 180° and 270°:

If the EPS mark is re-orientated then the square preview will show this.

Hot Spot

The hot spot is the point in the EPS mark that is chosen to line up exactly with
the selected position(s). Use this in conjunction with the position(s) and offsets
to place the custom mark. The default hot spot is Centre but there are several
other choices:

For Example:

1. To print a colour bar centred along the top, select the top middle position
together with the centre hot-spot selection.

2. To print a colour bar left aligned along the top, select the top left position
together with the left edge hot-spot selection.

3. To print a rotated colour bar vertically and top-aligned down the left side,
select the top left position together with the top edge hot-spot selection.

4. To print a rotated colour bar vertically and bottom-aligned up the right
side, select the bottom right position together with the bottom edge hot-
spot selection.

Apply To

This is used to select which blocks the custom mark should print on. For some
marks you may wish to print them on all blocks, but for other marks only print
on some blocks or at certain regular intervals. The following choices are
available:

All Blocks

Print the custom mark on all blocks.

Even Blocks

Print the custom mark on all even blocks.
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Odd Blocks

Print the custom mark on all odd blocks.

Points to remember

• To save a Custom Mark, you must select an EPS file and at least one
position. Otherwise, the Save button is disabled. This is the initial state
of the dialog when creating new custom marks.

• For each custom mark be aware of:

• which positions have been selected

• what offsets are set. Remember they apply to all positions equally.

• which hot spot has been selected. This could dramatically change the
position of the custom mark on the block.

• the orientation of the custom mark

• the scaling of the custom mark.
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PREFERENCES

The Preferences Dialog

This dialog is used to specify your particular preferences (defaults) for the
way the program works and what appears in certain dialogs. The preferences
are saved permanently, so they remain in effect the next time the program is
used.

To display this dialog click the Preferences button in the Queue Setup dialog:

Default Driver

This is used to specify the default PostScript Type that will be used to process
files. If you chose AutoDetect then the PostScript type of a file is detected
automatically, and file types may be mixed.

Default Units

This is used to specify the default units used throughout the program. The
following choices are available:

Clipping Area

Some users will be working with pages that bleed (print beyond the edge of
the page). This can cause problems when printing impositions because one page
can bleed onto another. To avoid this, the user has the option of limiting the
bleed to one of the following:
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None

Not limiting the bleed at all and leaving the bleeds as they were in the
original file.

Clip to Page

Limits the bleed to the edges of the page.

Clip to Trims

Limits the bleed to the edges of the trims.

Crop Mark Length

Crop Mark Length is used to control the length of the crop marks. Sometimes an
imposition will only just fit on an imagesetter, leaving very little room for crop
marks. Therefore, it is important to be able to control their length. Rather
than making the user repeatedly change the length of crop marks for different
jobs, Page Pairer allows the user to specify a range for the length of the crop
marks. Page Pairer will then try to print them with the Preferred Crop Mark
Length but will reduce them down to the Minimum Crop Mark Length, i f
necessary.

Preferred

Preferred is used to specify the preferred length of the crop marks.

Minimum

Minimum is used to specify the shortest acceptable length of the crop marks.

Echo Messages to RIP

If this check box is selected then messages are placed in the output PostScript
file which report to the RIP at which stage the processing of the file has
reached.
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UNINSTALLING USERS

From the Client
A user can uninstall themselves from a Server to free their slot on the Server.
You can only uninstall a user if they are currently logged onto the Server.

To uninstall a user

1. From the Client software select Installation from the Edit menu, and click
OK.

2. The Client Server Setup dialog will show the currently logged in Servers.
Select the Server from which you want to uninstall and click Uninstall
Server:

3. The Server will be removed from the list and the vacant slot will be
available for another user to log into.

From the Windows NT Server

1. From the Server software, select Users… from the Edit menu.
2. The Users dialog will show a list of all the users. Select the user that you

want to uninstall and click Uninstall. Note that only currently logged out
users can be uninstalled from the server.
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3. The User will be removed from the list and the vacant slot will be
available for another user to log in.

From the UNIX Server
1. Log out all Page Pairer Clients
2. Stop the Page Pairer Server software
3. Delete Clients.dat and Clients.bak files which can be found in the data

directory of your Page Pairer Server installation
4. Restart the Page Pairer Server. (Your users may have to repeat the login

process the next time they start the Page Pairer Client.)
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SETTING UP DIFFERENT SECURITY
LEVELS

Four levels of security can be set up by creating a ‘password.txt’ file in the
installation folder at the Server. This file should contain password
information in the following format:

level, password

For example:

1, Admin
2, supervisor
2, manager
4, monitor
3, JOURNALIST
etc.

The levels don't have to be arranged in any particular order, and also the
number of spaces and tabs after the comma is irrelevant. Passwords you type
here are case-sensitive, i.e. the users will have to type them in exactly the
same format as they are here.

Once this file is created every time on logging in a password dialog on the
Client will pop-up. If this dialog is cancelled the Client software will quit.
However if a correct password is entered then the appropriate level of access
to Page Pairer features will be assigned:

Level 1 - All command buttons and menu items available.

Level 2 – No queue editing can be done:
File Menu: Print Job Setup, Device Setup

and Print Marks disabled
Queue List Dialog: New, View/Edit, and Delete

buttons disabled
Progress Dialog: Print Job pop-up dialog

disabled, all other buttons
available.

Level 3 –  No command buttons available in Queue List Dialog.

Progress Dialog: Print Job pop-up dialog
disabled, all other buttons
available.

Level 4 – Only queue monitoring possible

The security level can also be changed at the Client while Page Pairer is
running by selecting 'Security...' item under the Edit menu.

Every time you edit the ‘password.txt’ file the Server part of the Page Pairer
will need to be restarted.
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PPCONFIG FILE

This file sits at the root of the Page Pairer Server installation, and if you ever
edit it, you should restart the server for the change to take effect. Here
follows a short explanation of all parameters:

QSTATUS_TIMEOUT=10 (seconds)
Sets the refresh rate of the status file (*.sts*) and of the console
display (unix only).

QSREAD_TIMEOUT=60 (seconds)
Time out value for loading queue data files. The server at the start-up
reads all queues, and if there were any problems with it an error would
be reported in 60 seconds.

QSWRITE_TIMEOUT=60 (seconds)
Time out value for writing queue data files to the disk. This happens
every 10 seconds (value specified in the next parameter
‘QSBACKUP_TIMEOUT’). If there were any problems an error would
be reported in 60 seconds.

QSBACKUP_TIMEOUT=20 (seconds)
As mentioned above, this value specifies how often queue data is
written to the disk, i.e. backed up

QFILES_STABLE_DELAY=15 (seconds)
Before processing files Page Pairer checks whether files have become
‘stable’, i.e. neither ‘file size’ nor ‘file last modified’ values have
changed in the last 15 seconds. If you have a fast machine or aren’t
dealing with particularly large files then this value can be lowered
which would speed up the whole process.

CMSG_REPLY_TIMEOUT=20 (seconds)
Currently not used

SMSG_REPLY_TIMEOUT=20 (seconds)
Currently not used

MSG_SERVICE_TIMEOUT=10 (seconds)
Currently not used

REGID_CHECK_TIMEOUT=10 (seconds)
Currently not used

BLOCKS_FREE_ALARM=10000 (kilobytes)
If the free space on the partition where the Page Pairer is installed
falls below this value (10 Mb) the server would give you a warning.

QJOB_TIMEOUT=1000 (seconds)
The server gives up if a job is not completed in specified time.

QCYCLE_LIMIT=99
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Every time a queue is reset, the ‘queue cycle’ value gets increased by
one which affects the names of the output files (standard Page Pairer
only). When it ticks over the specified value it gets reset to one.

QCHCK4END_MAX=60 (seconds)
Currently not used

MAX_JOBS_RUNNING=3
This value specifies how many jobs (here job means pairing two files
(or four if 4UP) can be run concurrently. If you have a powerful machine
you could experiment with this value.

QPROC_PRIORITY=10
Used to specify the priority of the process (nice value). Applies only
on Unix.

PAGENUM_FIRST=0
If this value is set to 1, then file names should have page number
specified first, e.g. 01.filename.

ERROR_RETRY=0
In case of an error this value specifies how many times Page Pairer
will try to reprocess a job before it gives up. Zero is the most sensible
value as the causes of errors are usually of a serious nature.

INTERNAL_SPOOL=0
If this is set to 1 then files are copied into the .qdr folder (root of
installation) for processing. However this should not be used.

IS_COMPOSITE_BLACK=1
If this is set to 1 then composite pages are treated as black separations.
Setting this to 0 allows the use of composite colour bars and custom
marks.

USE_EXCL_READ_CHECK=1
As mentioned above Page Pairer, before processing files, checks
whether files have become ‘stable’. This is an additional check where
files are tested for opening in ‘exclusive-read’ mode. Applies only to
Windows NT platform.

UNIX_CONSOLE_DISPLAY=1
This flag controls whether Page Pairer status is displayed in the
console window (unix only).

POSTSCRIPT_LEVEL=2
This flag specifies postscript level PDF files will be converted to when
doing PDF processing.
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TROUBLESHOOTING

Pair Errors

If an error is recorded for a pair (or a four-up) in the Queue Progress or Queue
Status windows, then it is likely that one of the input files for the pair (or
four-up) is not of the same PostScript type as the others or has some other
incompatibility problem. First of all make sure that the input PostScript files
are not corrupted. This accounts for most of the reported problems. Test your
input files by downloading them directly to your RIP or by creating a PDF f i le
if you have Adobe Acrobat Distiller installed.

A more detailed explanation of the error can be found in the Queue.log file in
the ADMIN folder. If the error logged is “Error loading files” or “Error
processing files” you should check if the postscript drivers (in
…\iplogin\drivers folder) are up-to-date, and if that is not the case you
should download the latest set from the FTP site (ftp.farrukh.co.uk).

If you experience problems processing PDF files please refer to Appendix A -
Processing PDF Files of this manual.

If a file does cause an error all input files for that pair (or four-up) are moved
to a directory called Error inside the queue input folder. When the problem is
fixed simply reset the pair and send the corrected input files for the pair (or
four-up) to the queue input directory again.

Queue Errors

If the status of a queue changes to ERROR then a problem with the queue has
occurred which the software is unable to rectify. Check the Queue.log file in
the ADMIN folder for a more detailed description of the error.

Dongle Errors

If you encounter any problems accessing the dongle, make sure that the dongle
is attached to the parallel port on the back of the server.  Check that the
dongle drivers have been installed successfully by looking at the 'Devices'
Applet under 'Control Panel', and remember to restart your machine after the
dongle drivers have been installed.

Clients Cannot Login To Page Pairer Server

All the client licences are used up. Page Pairer Server only allows five unique
clients to login. The same username cannot login from another workstation.
Once this limit is reached, new login requests will be refused. If you get logins
refused and it seems that no-one in your organization can use the server, it is
possible that 1 user has registered several userids which may no longer be
valid. You need to uninstall one or more users – see the chapter Uninstalling
Users above.

If you still cannot log in you should check if the volumes.lst file exists in the
iplogin folder and if it contains a correct list of Mac published volumes. If i t
looks OK you should then delete Page Pairer preferences, remount the shared
volume and try to log in again.
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Unusual characters in file names

If you find that certain files in the Input folder never get processed and they
don’t get moved to ERROR folder either it is possible that they contain some
unusual characters (e.g. ∞, ¶, ©, ™, etc.) which Windows NT Server cannot
recognise. If that is the case just rename the file and try to process it again.

Not Enough Disk Space

The queue manager periodically performs a disk space check on its installation
directory. If the amount of free disk space falls below approximately 10 Mb
then a warning message will be written to screen and the ipclnmgr.log file. The
queue manager will refuse to continue processing jobs until the required free
space is restored. Please note that if you started the queue manager from a
terminal, shell or command tool window that has since been quit, the warning
message will only appear in the log file.
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APPENDIX A – PROCESSING PDF
FILES

Introduction
Page Pairer Version 3 brings the capability to transparently impose PDF
(Portable Document Format) files. To the end user, PDF files are handled just
like PostScript files. PDF and PostScript files can also be mixed.
This section outlines the requirements for processing PDF files and provides
some guidance to ensure that software settings are appropriate for PrePress
workflows.

System Requirements

To easily process PDF files you need:

•  Adobe Acrobat v4.0 Exchange (on the Server) and Distiller

Setting up Acrobat
From Acrobat open any PDF file.  Go to the Print Dialog.  Ensure that the
option "Fit to Page" is not selected. This ensures that your input files are
not scaled down.

(Note: when processing PDF files Acrobat Exchange should NOT be
already running)

•  A Printer named "Imposition Publisher" that is set to print to a local f i le
port. (Windows NT Server only)

Setting up the "Imposition Publisher" Printer: -
"Imposition Publisher" printer should be automatically created first time
you run the software. If you get the message "Default Driver 'Apple
LaserWriter Select 360' not found. You may experience problems with PDF
processing" you should check if an appropriate PostScript driver has been
selected for the "Imposition Publisher" printer.

In case the printer has not been created at all you can set it up manually:

4. Go into the Printers Control Panel.
5. Double click "Add Printer".
6. When asked who will manage the printer select "My Computer".

Click next.
7. Click "Add Port".  Double click Local Port.  Enter a file path. This will

be used by Imposition Publisher to create temporary PostScript files.
For example, you may enter "C:\Temp\pdftops.prn". Press Enter and
then select this port.  Click Next.

8. For the Printer, choose an appropriate PostScript device from the
Printer list. Click Next. You may need your Windows NT installation
files if you are installing a new device, or you may select "Keep
existing driver" for an already installed device. Click Next.

9. Change the Printer name to "Imposition Publisher".  Click Next.
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10. The printer need not be shared.  Click Next.
11. Click Finish.

Note:

On the start-up Page Pairer will search for Acrobat and in the ipserver/ip
folder the file ipreader.cmd will be created which will contain the path
in the form IPPREVTOOL=/usr/bin/acroread (UNIX platforms).

If running Windows NT then in the installation directory the f i le
Reader.dat will be created which will contain the path.

 If you have problems you should make sure that this path points to the
right application i.e. Acrobat 4.0, and if necessary you can edit i t
manually.

Software Settings

To ensure that PDF files are handled effectively, it is necessary to change a
number of Acrobat settings. To pair PDF files effectively, you need to change
some of the Exchange and Distiller default settings.

You may need to crop the PDF pages to the correct page size in Acrobat
Exchange, to ensure that Page Pairer can correctly pair them.

In order to ensure the output quality of PDF files, it is necessary to change a
number of Acrobat Distiller default settings.

If you are using a PostScript Level 1 output device, you may need to change one
of Page Pairer’s default settings.

Acrobat Exchange

Fit to Page

From Acrobat open any PDF file.  Go to the Print Dialog.  Ensure that the
option "Fit to Page" is not selected

Cropping Pages

It may be necessary to crop the PDF pages to the finished trim size as Page
Pairer may not be able to work out the correct page size.

To do this:

1. Open the PDF files in Acrobat Exchange

2. Select Crop Pages… from the Document menu.
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3. Enter margins for all four edges so that the finished PDF document is the
actual trim size required.

4. Confirm that you want all the pages in the document to be cropped.

5. Save the PDF document.

The PDF file is now ready to be paired with Page Pairer.

Exchange Preferences

Change the following General Preferences settings:

1. Switch off Display Splash Screen at Start-up.

2. Switch off Display Open Dialog at Start-up.

3. Switch off Skip Editing Warnings.

Acrobat Distiller

Creating PDF Files to Impose

1. When in QuarkXPress, make sure that, if any special spot or Pantone
colours are used, then you do not have Separations checked on in the Edit
Colors dialog box.

2. Use Save as EPS option in Quark, otherwise the PostScript file created
will automatically convert the spot colours to CMYK, regardless of what
you did in the step 1.
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3. Move the two files called prologue.ps and epilogue.ps from the High-end
folder, found in the Xtras folder of Acrobat Distiller, to the Distiller
folder. Distiller uses these files to include spot colours in the PDF file
instead of converting the spot colours to process colours. (For more
information about prologue.ps and epilogue.ps files, see the Acrobat
Distiller Online Guide.)

4. Restart Distiller.

Distiller Preferences

In the Distiller Preferences dialog:

1. Switch off Notify if cannot connect to Watched Folder. Ensure that any
watched folders are accessible.

2. Switch off Display warning if start-up volume is nearly full. Ensure that
there is sufficient space on the start-up volume to process your files.

Distiller Job Options

General

In Acrobat Distiller Job Options, General tab:

1. Select Acrobat 3.0 for Compatibility.

2. Deselect ASCII Format.

3. Enter the default resolution (dpi) of the intended final output device in
the Default Resolution box.

4. Enter your page size in the Default Page Size boxes, in case Distiller does
not find the paper size in the PostScript file.
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Compression

This controls the file size and image quality. In Acrobat Distiller Job Options,
Compression tab:

1. Select Compress Text and Line Art.

2. For Color Bitmap Images select Downsample to and enter 400 dpi. Select
the Automatic Compression and ZIP/JPEG Low option.

3. For Grayscale Bitmap Images select Downsample to and enter 400 dpi.
Select the Automatic Compression and ZIP/JPEG Low option.

4. For Monochrome Bitmap Images, select the Downsample option and enter
the resolution of the intended final output device. Also select Manual
Compression and CCITT Group 4.

Font Embedding

In Acrobat Distiller Job Options, Font Embedding tab:

1. Select Embed All Fonts so that Distiller adds all the fonts used in the
document into the PDF file.

2. Select Subset Fonts Below and specify 99%.

Advanced

In Acrobat Distiller Job Options, Advanced tab:
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1. Select Distill with prologue.ps / epilogue.ps if your document includes spot
colours. Move the two files called prologue.ps and epilogue.ps from the
High-end folder, found in the Xtras folder of Distiller, to the Acrobat
Distiller folder.

2. Deselect Convert CMYK Images to RGB.

3. Select Preserve OPI Comments if your document includes placeholder
images for Open PrePress Interface (OPI) images.

4. Select Preserve Overprint settings if you want Distiller to include the
overprint settings included in the PostScript file in the PDF file it creates.

5. Select Preserve Halftone Screen Information if you want Distiller to
include the halftone screen information included in the PostScript file.

6. Select Preserve for Transfer Functions

7. Select Preserve for Under Color Removal / Black Generation.

5. Select Unchanged for Color Conversion.
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INDEX
Alignment, 38

Offsets, 43
Orientation, 44
Punch Control, 42

Alignment Dialog, 42
Arrived, 26
AutoDetect Driver, 64
Block Number, 52
Block Spacing, 42
Bottle, 35
Centre Crosses, 48
Centre Guides, 48
Client, 7
Client Manager, 7
Clipping, Default settings, 64
Collating Marks, 49
Colour Bar, 49
Colour Bar Offset, 54
Composite pages, 71
Continuous Devices, 46

Maximum Depth, 46
Strip Printing, 46

CPC 4 Mark, 50
Create Preview Files, 30
Creating Custom Print Marks, 54
Creating Print Devices, 38
Creep, 35
Crop Mark Length, 65
Crop Mark Length, 53
Crop Marks, 48
Custom Label, 33
Custom Mark Options Dialog, 60
Custom Marks

Copy, 58
Delete, 58
Disabled, 50
Edit, 57
EPS File, 60
Hot Spot, 62
Name, 60
Offsets, 61
Offsets From, 61
Orientation, 62
Positions, 61
Preview EPS, 50, 61
Printing, 62
Save, 56
Scaling, 61

Custom Marks List Dialog, 59
Custom Print Marks, 54
Date & Time, 52
Default Driver, 64
Default Job Setting, 30
Delete Queue, 24
Deleting Custom Print Marks, 58
Deleting Print Devices, 39
Device Setup, 38

Block Spacing, 42

Delete, 42
Device Pop-up, 40
Maximum Depth, 41
Media Height, 41
Media Width, 41
Offsets, 41
Paper Size, 40
Save, Save As, 42

Device Setup & Alignment, 40
Device Setup Dialog, 40
Dialogs

Alignment, 42
Custom Mark Options, 54, 60
Custom Marks List, 54, 59
Device Setup, 40
Job Setup, 36
Page Setup, 30
Preferences, 64
Print Marks, 47
Queue List, 24
Queue Options, 33
Queue Progress, 26
Queue Setup, 29
Queue Trims, 35
Standard Mark Offsets, 53
User Label, 51

disk space, 74
Document Job Title, 52
Dongle Driver, 14
double page spreads, 21
Duplicate Pages, 33

Number of Copies, 33
Page Number, 33

Duplicates, 7, 22, 23
Echo Messages to RIP, 65
Edge Trims, 35
Editing Custom Print Marks, 57
Error, 26
File List

Margins, 31
Orientation, 31
Units, 31

File Names
Input files, 21
Output files, 23

File Naming, 21
Grip Mark, 50
Hold All, 27
Hold/Release, 27
Horizontal & Vertical Trims, 35
Hot Spot, 62
Imposition Name, 52
Input Folder, 30
Installing clients, 16
ipclnmgr.log file, 74
Job Folders, 30
Job Number, 23
Job Sets, 36
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Job Setup
Delete, 37
Device, 36
Mark Set, 36
Mirror, 37
Negative, 37
Printer, 36
Reverse User Label, 37
Save, Save As, 37
Scaling, 36

Job Setup Dialog, 36
Licence Agreement, 3
Menus

Edit
Marks Setup..., 54
Print Marks..., 47

File
Device Setup..., 40

Mirror, 37
Yellow Plate, 37

Multiple Page Files, 22
Negative, 37
New Custom Marks, 54
New Queue, 24
Number of Copies, 33
Odd Pair, 29
Offsets, 41, 43
Options, 32
Orientation of output, 44
Output Files, 23
Output Folder, 30
Page Number

Duplicates, 33
Page Outlines, 48
Page Setup, 30
Page Status, 26

Arrived, 26
Error, 26
Processed, 26
Processing, 26
Waiting, 26

Pages in Paper, 29
Pages Processed, 25
Pair Options, 32, 33, 35
Plate Colour, 52
PPCONFIG, 70
Preferences, 64

Clipping, 64
Crop Mark Length, 65
Default Driver, 64
Echo Messages to RIP, 65

Preferences Dialog, 64
Preview, 27
Print Devices

Deleting, 39
New, 38

Print Job popup, 27
Print Mark Offsets, 53
Print Marks, 36, 47

Centre Crosses, 48
Centre Guides, 48
Collating Marks, 49

CPC 4 Mark, 50
Grip Mark, 50
Page Crop Marks, 48
Page Outlines, 48
Registration Marks, 49
Signature Marks, 49
standard, 47
Standard Colour Bar, 49

Print output files, 30
Print Settings, 32
Printer Pairs, 22
Printers setup, 11
Printing, 36, 41, 42
Processed, 26
Processing, 26
Progress, 24
Publication Size, 29
Punch Control, 42
Punch Holes, 43
QuarkXPress, 21
Queue List, 24

Delete, 24
Name, 25
New, 24
Pages, 25
Processed, 25
Progress, 24
Reset, 24
Status, 25
Suspend/Resume, 24
Type, 25
View/Edit Settings, 24

Queue Name, 29
Queue Options

Custom Label, 33
Queue popup, 27
Queue Progress, 26

Hold All, 27
Hold/Release, 27
Preview, 27
Release All, 27
Reset Page, 27
Reset Pair, 27

Queue Setup, 25, 29
Create Preview Files, 30
Default Job, 30
Default Page Setup, 30
Input Folder, 30
Job Folders, 30
Odd Pair, 29
Options, 32
Output Folder, 30
Pages in Paper, 29
Preferences, 32
Print output files, 30
Printing…, 32
Queue Name, 29
Queue Type, 29
Sections, 30
Trims, 32
Webs, 30

Queue Trims, 35
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Bottle, 35
Creep, 35
Edge Trims, 35

Queue Type, 29
queue.log, 8
Registration Marks, 49
Registration, CPC 4 and Grip Mark Offsets, 54
Release All, 27
Reset All Blocks, 44
Reset Block, 44
Reset Page, 27
Reset Pair, 27
Reset Queue, 24
Resume, 24
Reverse User Label, 37
Saving a  Custom Print Mark, 56
Scale Horizontal, 37
Scale to Fit, 36
Scale Vertical, 37
Sections, 30
Security Levels, 68
Signature Marks, 49
Signature Number, 52
Slug, 51
Solaris, 9
Spreads, 21, 23

Stabilistion delay, 70
Standard Print Marks, 47, 48
Status, 25
Strip Printing, 46
Suspend, 24
System Requirements, 9
Timeout, 70
Trims, 32
Troubleshooting, 73
Uninstalling Users, 66
Unix display, 71
Unix installation, 10
User Label, 51

Block Number, 52
Date & Time, 52
Document Job Title, 52
File Name, 52
Imposition Name, 52
Plate Colour, 52
Signature Number, 52

Valid Input File Names, 21
View/Edit Settings, 24
Waiting status, 26
Webs, 30
Windows NT installation, 14
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